### Legal information

#### Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

<table>
<thead>
<tr>
<th>Notice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DANGER</strong></td>
<td>Indicates that death or severe personal injury will result if proper precautions are not taken.</td>
</tr>
<tr>
<td><strong>WARNING</strong></td>
<td>Indicates that death or severe personal injury may result if proper precautions are not taken.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> with a safety alert symbol</td>
<td>Indicates that minor personal injury can result if proper precautions are not taken.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> without a safety alert symbol</td>
<td>Indicates that property damage can result if proper precautions are not taken.</td>
</tr>
<tr>
<td><strong>NOTICE</strong></td>
<td>Indicates that an unintended result or situation can occur if the relevant information is not taken into account.</td>
</tr>
</tbody>
</table>

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

#### Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

#### Proper use of Siemens products

Note the following:

<table>
<thead>
<tr>
<th>Notice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WARNING</strong></td>
<td>Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.</td>
</tr>
</tbody>
</table>

#### Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

#### Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1. Introduction .......................................................................................................................... 5
2. Preparation ............................................................................................................................ 7
3. Learning units ...................................................................................................................... 11
   3.1 1. Step: Mount mounting rails and modules ................................................................. 11
   3.2 2. Step: Wiring the power supply and CPU ................................................................. 13
   3.3 3. Step: Commissioning the hardware ....................................................................... 14
   3.4 4. Step: Set up the PG/PC interface ........................................................................... 15
   3.5 5. Step: Configuring hardware in HW-Configuration of STEP 7 .............................. 16
   3.6 6. Step: To insert CPU 317-2 PN/DP and assign it and IP address ......................... 17
   3.7 7. Step: Commissioning the CPU 317-2 PN/DP ......................................................... 20
4. Further Information ............................................................................................................ 21
Introduction

In the following steps we will show you the basics of configuring the PROFINET interface, using the CPU 317-2 PN/DP as an example.

The PROFINET interface for the CPU 314C-2 PN/DP, 315-2 PN/DP and 319-3 PN/DP is configured in the same way as for the CPU 317-2 PN/DP.

This process will take one to two hours, depending on your experience.
Preparation

Scope

<table>
<thead>
<tr>
<th>CPU</th>
<th>SIMATIC Micro Memory Card required for operation?</th>
<th>As of firmware version</th>
</tr>
</thead>
<tbody>
<tr>
<td>314C-2 PN/DP</td>
<td>yes</td>
<td>V3.3</td>
</tr>
<tr>
<td>315-2 PN/DP</td>
<td>yes</td>
<td>V3.2</td>
</tr>
<tr>
<td>317-2 PN/DP</td>
<td>yes</td>
<td>V3.2</td>
</tr>
<tr>
<td>319-3 PN/DP</td>
<td>yes</td>
<td>V3.2</td>
</tr>
</tbody>
</table>

The order number can be found in the manuals, e.g. the operating instructions CPU 31xC and CPU 31x: Installation (http://support.automation.siemens.com/WW/view/en/13008499).

Requirements

- Basic knowledge of electronic and electrical systems engineering.
- Knowledge in the area of network engineering would be of advantage.
- You have already worked with the STEP 7 programming software.
- You are familiar with the Microsoft® Windows™ operating system.

**WARNING**

Operation of an S7-300 as part of plants or systems is subject to special rules and regulations, which depend on its field of application. Please make sure that you adhere to the applicable safety and accident prevention regulations, for example IEC 204 (emergency stop systems).

You risk severe injury, or damage to machines and equipment if you ignore these regulations.
**Material and tools required**

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
<th>Order number (Siemens)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mounting rail</td>
<td>e.g. 6ES7390-1AE80-0AA0</td>
</tr>
<tr>
<td>1</td>
<td>Power supply (PS) module</td>
<td>e.g. 6ES7307-1EA01-0AA0</td>
</tr>
<tr>
<td>1</td>
<td>CPU 314C-2 PN/DP or CPU 315-2 PN/DP</td>
<td>e.g. 6ES7314-6EH14-0AB0</td>
</tr>
<tr>
<td>1</td>
<td>CPU 317-2 PN/DP or CPU 319-3 PN/DP</td>
<td>e.g. 6ES7317-2EK14-0AB0</td>
</tr>
<tr>
<td>1</td>
<td>SIMATIC Micro Memory Card</td>
<td>e.g. 6ES7318-3EL01-0AB0</td>
</tr>
<tr>
<td>1</td>
<td>Programming device (PG) or PC with Ethernet network card, 100 Mbps, full duplex</td>
<td>depending on the configuration</td>
</tr>
<tr>
<td>1</td>
<td>Switch, e.g. SCALANCE X208</td>
<td>e.g. 6GK5208-0BA00-2AA3</td>
</tr>
<tr>
<td>1</td>
<td>Industrial Ethernet twisted pair cable (Cat5) with RJ45 connectors (patch cable TP Cord RJ45/RJ45, length = 6 m)</td>
<td>e.g. 6XV1850-2GH60</td>
</tr>
<tr>
<td>various</td>
<td>M6 screws and nuts (lengths depend on place of installation) and matching wrench / screwdriver</td>
<td>commonly available</td>
</tr>
<tr>
<td>1</td>
<td>Screwdriver with 3.5 mm blade</td>
<td>commonly available</td>
</tr>
<tr>
<td>1</td>
<td>Screwdriver with 4.5 mm blade</td>
<td>commonly available</td>
</tr>
<tr>
<td>1</td>
<td>Side cutter and cable stripper</td>
<td>commonly available</td>
</tr>
<tr>
<td>1</td>
<td>Crimp tool for wire ferrules</td>
<td>commonly available</td>
</tr>
<tr>
<td>0.5 m</td>
<td>1-wire flexible cable, conductor cross-section 1 mm² with wire-end ferrules, for connecting the power supply and CPU</td>
<td>commonly available</td>
</tr>
<tr>
<td>X m</td>
<td>Cable for grounding the mounting rail with 10 mm² cross-section and cable lug to fit M6, length appropriate for local requirements.</td>
<td>commonly available</td>
</tr>
<tr>
<td>X m</td>
<td>3-wire flexible power cable (230/120 V AC) with &quot;Schuko&quot; plug; length to suit local requirements with suitable wire-end ferrules with shrouded contacts.</td>
<td>commonly available</td>
</tr>
</tbody>
</table>
Configuring the PROFINET interface

1. Status and error displays
2. Bay for SIMATIC Micro Memory Card
3. Mode selector
4. Industrial Ethernet twisted pair cable for connecting to additional PROFINET devices
5. Industrial Ethernet Twisted Pair cable for interconnecting PN interface X2
6. Programming device (PG) with STEP 7 software
7. Mounting rail
8. Power supply ON/OFF

Figure 2-1 Configuration with CPU 317-2 PN/DP
Power supply (PS) module

CPU 317-2 PN/DP

PROFINET Port 1
The port 1 status is signaled using a two-colored LED (green/yellow):
- LED lights up green: LINK to a partner is active
- LED changes to yellow: Active data traffic (RX/TX)
R: Ring port for setting up a ring topology with media redundancy

PROFINET Port 2
The port 2 status is signaled using a two-colored LED (green/yellow):
- LED lights up green: LINK to a partner is active
- LED changes to yellow: Active data traffic (RX/TX)
R: Ring port for setting up a ring topology with media redundancy

MAC address and 2D bar code

2. Interface X2 (PN), with dual-port switch

1. Interface X1 (MPI/DP)

Power supply connection

Connecting cables between PS and CPU

Strain relief

Figure 2-2 Wiring the power supply and CPU
Learning units

3.1 1. Step: Mount mounting rails and modules

Installation sequence

From left to right: Power supply PS 307 - CPU 317-2 PN/DP.

The configuration diagram gives you an overview of the overall configuration.

Installing and grounding the mounting rail

1. Screw on the mounting rail (screw size: M6). Make sure to maintain a minimum clearance of 40 mm above and below the mounting rail.

   When mounting it on a grounded metal panel or on a grounded equipment mounting panel, make sure you have a low-impedance connection between the mounting rail and the mounting surface.

2. Connect the rail to the protective conductor. An M6 protective conductor screw is provided on the mounting rail for this purpose.

   Stipulated cross-section of the cable connection to the protective conductor: at least 10 mm².
Installing modules on the mounting rail

1. First of all, insert the power supply module. Slide it to the left as far as the grounding screw of the mounting rail. Fasten the power supply module.

2. To connect further modules, insert a bus connector into the CPU.

3. Hang in the CPU (1).

4. Slide it up to the left module (2).

5. You can then swing it down (3).

6. Tighten the modules with a torque of 0.8 to 1.1 Nm.

7. Insert a SIMATIC Micro Memory Card into the CPU (4).
   Delete the content of a SIMATIC Micro Memory Card with unknown content before you use it in the programming device.

8. You also need to install one digital input and one digital output module to the right of the CPU. To do this, repeat steps 2 to 6 as applicable.
2. Step: Wiring the power supply and CPU

**WARNING**

Ensure the S7-300 is completely disconnected before wiring!

You may come into contact with live wires if the S7-300 is connected to the power supply.

**Procedure**

1. Open the front panels of the power supply and the CPU.
2. Detach the strain relief clip from the power supply.
3. Strip the flexible power cable.
4. Correctly crimp on wire-end ferrules.
5. Connect the CPU to the power supply (blue to terminal M, black to terminal L1, protective conductor to terminal PE).
6. Screw the strain relief clamp in place.
7. Next, wire the power supply to the CPU. Use flexible cable with a conductor cross-section of 1 mm².
   - Strip the ends to a length of approx. 6 mm.
8. Crimp wire-end ferrules to the ends.
9. Connect power supply terminals L+ and M to the terminals on the CPU.
3.3 3. Step: Commissioning the hardware

Procedure

1. Connect your CPU (e.g. port 1 of PN interface X2) to the PG/PC. Use the twisted pair cables with RJ45 connectors.
   Result: The PG/PC is interconnected with the CPU.

2. Connect the PROFINET I/O device (e.g. ET 200S) to your CPU (e.g. port 2 of PN interface X2). Use the twisted pair cable with RJ45 connectors.
   Result: The I/O device is connected to the CPU.

3. Verify that the SIMATIC Memory Card is inserted in the CPU slot.

4. Close the front panel cover of the CPU, then set the mode selector switch on the CPU to STOP.

5. Connect the power supply cable to the mains, then switch on the power supply module.
   Result: The power supply 24V DC LED lights up. All LEDs on the CPU light up briefly. The SF LED and the 5V DC LED remain on. The STOP LED then flashes and the CPU automatically carries out a memory reset.
   After completion, the STOP LED is lit.

6. Start your PG/PC, then run SIMATIC Manager from your Windows desktop.
   Result: A window opens with SIMATIC Manager.
4. Step: Set up the PG/PC interface

Procedure

1. Select "Start > SIMATIC > STEP 7 > Customize PG/PC interface".
   
   Result: The dialog box for setting the PG/PC opens.

![Set PG/PC Interface Dialog Box]

2. Select the access path. Then set the TCP/IP protocol for the network card used.
   
   Click "Properties". Select the "Assign project-specific IP address" option in the "Properties" dialog box. Confirm twice with "OK".
   
   Result: Your PG/PC settings are applied.
Create a new project in STEP 7
1. Select the menu command "File > New ...".
2. Enter a name for your project and click on OK to confirm.
   Result: A new project is created.

Add a new S7-300 station
Select "Insert > Station > SIMATIC 300 Station".
Result: The SIMATIC 300 (1) icon in the right-hand part of the window is highlighted.

Add a rail
1. In the right-hand part of the window, double-click first on the SIMATIC 300(1) icon and then on the Hardware icon.
   Result: The hardware configuration editor (HW Config) opens.
2. Insert your hardware components from the hardware catalog in the left-hand section of the window.
   If no catalog is displayed, use the menu command View > Catalog to activate it.
   In the hardware catalog, select SIMATIC 300 and then Rack 300. Drag-and-drop the mounting rail to the top section of the HW Config window.
   Result: This pastes the mounting rail into the upper section of the HW Config window.

Add the power supply
In the hardware catalog, navigate to PS 300. Drag-and-drop your power supply into slot 1 in the mounting rail.
Result: The power supply module is inserted into slot 1.

Note
You can click the power supply module to view its order number. The order number then appears in the box beneath the catalog.
3.6 6. Step: To insert CPU 317-2 PN/DP and assign it and IP address

Introduction

Each Ethernet node is identified by a internationally unique address. This "MAC address" is preset by the manufacturer and cannot be changed.

In the following steps you will assign an IP address in the Ethernet to this physical address.

Procedure

1. Navigate to CPU 300 in the hardware catalog. Drag-and-drop the CPU 317-2 PN/DP into slot 2 of the mounting rail.

   The CPU 317-2 PN/DP is inserted in slot 2. The properties window of the PROFINET interface X2 is displayed.

   The IP address for products as of V3.x can be activated by selecting the "Use different method to assign IP address" checkbox.

2. Enter the IP address and the subnet mask.

   When working on a corporate network, contact your network administrator for information about this address.

3. If you setup a connection via router, you must also enter the address of the router.

   When working on a corporate network, contact your network administrator for information about this address.

4. Click "New", then assign a name for a new Industrial Ethernet subnet. Confirm your entries with "OK".

   Result: You created a new Industrial Ethernet subnet.
5. Click on the "OK" button.
   Result: The properties window of the PROFINET interface X2 for CPU 317-2 PN/DP closes.

6. In HW Config you can also set the options for the PROFINET interface:
   In HW Config, double-click on PROFINET interface X2 or on the required port for the CPU 317-2 PN/DP.
   If you have selected port 1 or port 2, switch to the "Options" tab. You can customize the network settings on this tab if need be. Default is "Automatic Settings", which is usually sufficient for error-free communication. Communication problems may be caused by faulty network settings or by the automatic network settings. Problems can include failure to establish connections and frequent network errors.
   Select a network configuration that matches your network settings.
   Result: Customize the network settings in HW Config.

Save and compile your configuration

1. Select the menu command "Station > Save and compile".
   Result: The hardware configuration is compiled and saved.

2. Select the menu command "PLC > Download to module".
   Result: The dialog box for the selection of the target group is displayed.

CPU 317-2 PN/DP is already selected as the target module.
3. Confirm the dialog with "OK".

Result: The dialog box for the selection of the station address is displayed.

The CPU is not yet displayed in "stations reached".

4. Click "View".

Result: The programming device reads the MAC address and displays it in the dialog box.

5. Select the line with the MAC address of the CPU. Confirm with "OK".

Result: The message window opens.
6. Confirm the message with "Yes".

   Result: IP address is assigned to the CPU and the configuration is loaded.

   ![Assign IP address dialog box]

7. Close HW Config with the menu command "Station > Close". Answer the save prompt with "Yes".

   Result: HW Config is closed. The CPU now appears in the station in SIMATIC Manager.

---

3.7 7. Step: Commissioning the CPU 317-2 PN/DP

**Procedure**

Set the mode switch of the CPU to "RUN".

Result: The STOP LED is off. The RUN LED starts to flash and then assumes a continuous signal.

The LINK LED (green) indicates a physical Ethernet connection. The RX/TX LED (yellow) is lit or flashes when data are being transmitted/received via Ethernet.

---

**Note**

Note: The LINK LED and the RX/TX LED may also be combined in a two-colored LED.

---

**Result**

You have completed the STEP 7 configuration of the PROFINET interface X2 of your CPU 317-2 PN/DP.

- Other nodes can now access the CPU on the Ethernet subnet.
- The new functions now allow you to configure your project, or to reconfigure it, via the integrated PROFINET interface of the CPU.
- All PG/OP functions and other communication functions of the CPU 317-2 PN/DP are now available via the integrated PROFINET interface.
Further Information

Reference

For detailed information on address assignment for the PROFINET interface, please refer to the STEP 7 online help.

Diagnostics/Correction of Errors

Wrong operation, faulty wiring or a faulty hardware configuration may cause errors which the CPU indicates with the SF group error LED after a CPU memory reset.

For information on how to diagnose such errors and alarms, please refer to the operating instructions, CPU 31xC and CPU 31x: Installation (http://support.automation.siemens.com/WW/view/en/13008499).

Manuals containing further information

- PROFINET System Description (http://support.automation.siemens.com/WW/view/en/19292127)

Service & Support on the Internet

In addition to our documentation, we offer a comprehensive knowledge base on the Internet (http://www.siemens.com/automation/service&support).

There you can find:
- A newsletter containing the latest information on your Siemens products.
- The documents you need using the search engine in Service & Support.
- The bulletin board, a worldwide knowledge exchange for users and experts.
- Your local contact for Automation & Drives in our contact database.
- Information about on-site services, repairs and spare parts. You will find much more under "Services".